
SARDAR KAURAY KHAN PUBLIC HIGHER SECONDARY SCHOOL 

M.GARH.

 Weekly  Break-up for September,2020. 

Subject: English   Teacher: Mrs. Naghma  Class: 7th 

Week Dates Topics / contents 

1st 31—05 Sep Unit: 6 The machine stops. Reading, words’ meanings + 
Exercise: A 

2nd 07—12 Unit: 6 The machine stops. Exercise:B , 
STORY- The bear and two friends, Vocabulary: 

degrees of adjectives 

3rd 14—19 Grammar tree: chp 12 (A,B,C) chp: 13 (A,B,D) 

4th 21—26 Translation: Future 
Indefinite Tense, Future 

Continuous Tense 

5th 28—03 oct Self-Assessment 

Notes for the month of September,2020. 

English: A UNIT: 6       THE MACHINE STOPS   

Words’ meanings: Learn from the book. 

Exercise: A 

Answer the following questions.      

Q. a: Who are Vashti and Kuno?

Ans: Vashti is a woman and Kuno is her son. 

Q. b: Why can Vashti only talk for five minutes?

Ans: She can give him full five minutes because she must deliver her lecture

on ' Music during the Australian Period'.

Q. c: How does Vashti move around her room?

Ans: Vashti moves around her room in a mechanical chair 

Q. d: Why doesn’t Vashti want to travel in a airship?

Ans: Vashti doesn’t want to travel in a airship because she dislikes seeing the 

horrible brown earth, the sea and the stars in the dark. 
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Q. e: What does Kuno say that shocks Vashti?  

Ans:Kuno says that he doesn’t want to speak to his mother through the 

wearisome Machine. Vashti is shocked that he says something negative about 

the Machine.  

Q. f: What details do we learn about the rooms that people live in, in the 

underground world? 

Ans:The rooms are small, hexagonal and lit by a soft radiance. They have some 

kind of ventilation system. Music is played in them. Each room contains a 

chair, a reading desk and the lots of buttons and switches.                                                        

Q. g: What do we learn about Vashti and Kuno's personalities?  

Ans: Vashti is more obedient and seems to accept life in the Machine 

without question. Kuno questions the Machine and wants to do things 

contrary to the spirit of the Machine.  

Exercise: B 1: Similies. 

 a: a bee.        b: sky.              c: a brick.              d: a 

carrot.   e: tarcoal.       f:a mountain  g: a parrot.             

h: a lark.            

i: a Jew.           j: a whistle.     k: a lion.                 L: a dream 

m: a clock.      n: leather.       O: eating.  

 

English: B 

                          STORY    “THE BEAR AND TWO FRIENDS.”  

Once two friends set out on a journey. They promised to stand by each other 

in time of danger. They travelled on till they reached a jungle. Soon, they saw 

a big bear coming towards them. Both of them were greatly frightened. One 

of them climbed up a tree leaving the other to his fate. The other lay down on 

the ground and held his breath. The bear came near, smelt him and thinking 

him dead, went away. When the danger was over, the friend on the tree came 

down and asked, “ What did the bear whisper in your ear?” . He answered 

that the bear had warned him to beware of false friends.  

Moral :        

                          A friend in need is a friend indeed.   
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                                   THE GRAMMAR TREE  

Chapter: 12.     “Modal Auxiliaries” 

Exercise: A  

Identify the main verbs and helping verb in each sentence. Underline the 

main verbs and circle the helping verbs. (Helping verbs are in bold / italics).  

1: They can help you whenever needed.  

2: The little boy can ride a cycle all by himself.  

3: They could not work in time.  

4: Could I talk to you for minute?  

5: The chief could arrive any minute.  

6: She will never agree to do such a dishonest thing.  

7: He said the he would monitor the work for some time.  

8: We should consult a doctor. 

9: He may stitch a dress for his daughter.  

10: You must come to school in time for the assembly.  

Exercise: B 

1: Possibility     2: Possibility      3: Suggestion       4: Permission       5: ability  

6: suggestion    7:possibility       8: suggestion.      9: possibility       10: possibility 

Exercise: C  

1: can.                  2: should.              3: could.              4: could.               5: could 

6: may.                7: might.                8: should.           9: could.                10: may 

Chapter: 13                  “PHRASAL VERBS” 

Exercise: A  

Fill in the blanks.  

1: set to.             2: set up.               3: set out.           4: set in.            5: set on 

6: set off.           7: set down.          8: set aside.        9: set about.     10: set back.  

Exercise:B 

1: took over.— phrasal verb                              2: Take over— prepositional 

verb.                                            3: keep on— prepositional verb.                           

4: keep on — phrasal verb  

5: broke into — prepositional verb.                      6: broke into — phrasal verb  

7: run down — prepositional verb.                      8: running down — phrasal               

9: pulled up — prepositional verb.                      10: pulled up — phrasal verb.  

Exercise: D 

1: fall back.         2: fall behind.       3: fall upon.        4: fall out.        5: fall apart     

6: fall about        7: fall through      8: fall for.            9: fall to.         10: fall in. 
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                                                       TRANSLATION   

FUTURE INDEFINITE TENSE 

Formation: Affirmative Sentence — sub + will/shall + 1st form of verb + obj  

(I,we— shall.  He,she,it,you,they— will)  

Negative sentence— sub + will not/ shall not + 1st form of verb + obj.  

Interrogative sentence— Will / Shall + sub + 1st form of verb +obj + ?. 

   

  مہ لک ڑچای رھگ اجںیئ ےگ۔:1

 دری ےس وکسل ےچنہپ اگ۔املس 2:

 مہ وادلنی یک زعت رکںی ےگ: 3

 .وہ اس اسل ااحتمن دںی ےگ:4

ف رکے اگ5:  .وہ اےنپ وصقر اک ارتعا

 .وہ اچےئ ںیہن ےیپ اگ6:

 ےھجمواہں ےچنہپ ںیم اپچن ٹنم ںیہن ںیگل ےگ:7

 ایک آپ ریمے قح ںیم ووٹ ڈاںیل ےگ؟:8

 وہ اانپ ودع ہ بک وپرا رکے اگ؟:9

 ابرش بک وہیگ؟:10

                                                                                                                   HINTS.                       

                                                                                   

1: to visit 3: to respect 4: to take examination 5: to confess 7:to take 8: to vote for me 9: to fulfil.    
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FUTURE CONTINUOUS TENSE                                                

 

Formation: Affirmative Sentence — sub + will be /shall be + ing form of verb + obj   

 

Negative sentence— sub + will not be / shall not be + ing form of verb + obj.  

 

Interrogative sentence— Will / Shall + sub + be + ing form of verb +obj + ?.  

 

 وبدنا ابدنی وہ ریہ وہیگ:1

وہاگ2: ے راہ  زے رپ دکتس د  وہ ریمے دروا

وہاگ:3   دوھیب ریمے ڑپکے ارتسی رکراہ 

وہاگ:4   وہ ورزش ںیہن رک راہ 

  وہ وھجٹ ںیہن وب ل رےہ وہں ےگ:5

وہاگ:6  اہجز دنمسر ںیم ںیہن ریت راہ 

 . ولگ اتایلں اجب رےہ وہں ےگ؟ایک:7

 ؟ اہپڑوں رپ ربف ابری وہ ریہ وہیگایک:8

وہاگ.:9   اعرم اےنپ وادلنی ےک شقن دقم رپ لچ راہ 

 وہ امہرا ااظتنر  ںیہن رک رےہ وہں ےگ: 10

 

HINTS.                                                                                                                                 

  

1: drizzling 2: knocking 3: pressing 5: to tell a lie 6: sailing 7: clapping their 

hands 8: snowing 9: to follow the footsteps 10: to wait.                                           
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VOCABULARY.        

DEGREES OF ADJECTIVES 

Learn these degrees of adjectives with spellings.  

Positive degree  Comparative degree  Superlative degree  

Tall   Taller  Tallest  

Fair  Fairer  Fairest  

Black  Blacker  Blackest  

Strong  Stronger  Strongest  

Brave  Braver  Bravest  

Pale  Paler  Palest  

Pure  Purer  Purest  

Clear  Clearer  Clearest  

Heavy   Heavier  Heaviest  

Pretty  Prettier  Prettiest  

Dry  Drier  Driest  

Gay  Gayer  Gayest  

Fit  Fitter  Fittest  

Big  Bigger  Biggest  

Good  Better  Best  

Bad  Worse  Worst  

Much  More  Most  

Far  Further  Furthest  

Beautiful  More beautiful  Most beautiful  

Intelligent  More intelligent  Most intelligent  

Confused  More confused  Most confused  
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MUZAFFARAGRH 

NOTES FOR THE MONTH OF SEPTEMBER 

SUBJECT : SCIENCE                                                                                            CLASS: VII 
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  14 31 – 05 6  
Reading and Explanation of Ch# 6 “Simple Chemical 

Reactions” 

15 7 – 12 6  Short/Q + Exercise Ch# 6 

16 4 – 19 6  Long/Q Ch# 6 

17 21 – 26 6  Self Assessment for the month of Aug+Sep 

18 
28 – 3rd 

Oct 
6  Practical activities  

SCIENCE 
 

CLAS - 7 
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UNIT NO.6        SIMPLE CHEMICAL REACTIONS 

Short Questions 

 Answer these short questions 

Q.No.1 When do chemical changes happen? 

Ans: Chemical changes happen when the atoms in molecules join up 

with other atoms making a new substance during chemical reactions. 

Q.No.2 Differentiate between a chemical change and a physical change. 

Ans:  

Physical change Chemical change 

No new substances are made. 
One or more new substances are 

made. 
Energy is not always given out or 

taken in. 
Energy is always given out or taken 

in. 

It can be reversed. It is usually very difficult to reverse. 

 

Q.No.3 What is the easiest way of writing a chemical reaction? 

Ans: The easiest way of writing a chemical reaction is 

Iron + sulphur                iron sulphide 

Q.No.4 What name is given to the chemical involved ruled in a chemical 

reaction? 

Ans: The chemicals involved at the beginning of chemical reactants are 

called reaction. 

The chemicals produced as a result of chemical reaction are called products. 

Q.No.5 What type of chemical reaction is burning of magnesium in 

oxygen? 

Ans: Magnesium burns with oxygen and form magnesium oxide, it is 

called combination or synthesis reaction. 

Magnesium + oxygen             magnesium oxide 
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Q.No.6  Write down three things needed to keep a fire burning. 

Ans: Things are needed to keep a fire burning: 

Fuel:-    to burn 

Oxygen:-   for fuel to burn 

Heat:-   keep chemical reaction going on. 

Q.No.7  Explain why water can be used to put out a bonfire? 

Ans:  Water is used to put out a fire but it is not safe for some fires e.g. 

electrical fires, petrol fires etc. 

Q.No.8  Is magnesium burning in oxygen exothermic or 

endothermic? 

Ans:  Magnesium burning with oxygen is an exothermic reaction because 

lot of heat evolves during the reaction. 

Long Questions 

Q.No.1  Lime (calcium oxide) is produced by heating lime-stone 

(calcium carbonate) in Lahore kiln. Carbon dioxide is produced as waste 

product. 

(a) Is this reaction exothermic or endothermic?  

(b) Write a word equation for the production of lime. 

Ans:  Lime (Calcium Oxide) is produced when lime stone (Calcium 

Carbonate) is heated in a hot Kiln. Carbon Dioxide is given off as a waste 

product. The decomposition of lime stone is endothermic reaction because it 

requires heat.  

 The word equation for this reaction is:  

Calcium Carbonate                      Calcium Oxide + Carbon dioxide 
 (Lime stone)                    (Lime) 

Q.No.2  Explain the difference between exothermic endothermic 

reactions. 

Ans:  Exothermic Reactions:  

The reactions which give out heat are called exothermic reactions.  

Examples:  

i) Burning of methane is an exothermic reaction  
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Methane + Oxygen                     carbon dioxide + water + heat energy  

ii) Burning of magnesium ribbon in air is also exothermic.  

Magnesium + oxygen                   magnesium oxide + heat  

Endothermic Reactions:  

The reactions which need heat energy to be started are called 

endothermic reactions.  

Examples:  

i) When copper carbonate is heated it changes from a green 

powder to a black powder (copper oxide) and carbon dioxide.  

Copper carbonate +heat                  copper oxide plus carbon dioxide  

ii) Rusting of iron is also and endothermic reaction. 

Iron + oxygen + heat                   iron oxide 

Q.No.3  Explain why the reaction between iron and copper sulphate 

is an example of displacement reaction? 

Ans:  During a displacement reaction, one substance pushes out another 

substance to take it place.  

If an iron nail is put into a jar containing copper sulphate solution, some iron 

dissolves and displaces the copper in the solution. The copper is deposited on 

the nail.  

Iron + copper sulphate                       copper + iron sulphate 
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Q.No.4  What is a hydrocarbon? What happens to a hydrocarbon 

when it burns? 

Ans:  The compounds which contain the elements carbon and hydrogen 

are called  hydrocarbons.  

During burning these elements combine with oxygen to form 

carbon dioxide and water.  

Fuel + oxygen                        carbon dioxide + water + heat energy  

Examples:  

Methane is a hydrocarbon. When methane (natural gas) burns with 

oxygen it forms water and carbon dioxide. Heat energy is produced 

along with.  

Methane +  Oxygen                       water + carbon dioxide + energy  

The carbon dioxide produced in the reaction turns anhydrous 

copper-sulphate milky. 

Q.No.5 Why does our body need fuel?  Where does this fuel come from? 

Ans:  The human body needs fuel to produce energy. The food we eat 

provides us with fuel, mainly in the form of carbohydrates.  

Carbohydrates such as glucose contain elements carbon, hydrogen and oxygen. 

The carbohydrates react with oxygen inside the cells of the body. This is called 

respiration. 

                      Exercise 

Q.No.1  Multiple choice questions 

  1.  Which of the following is a characteristic of chemical change? 

(a) Can be reversed easily 

(b) Energy is not taken in or given out 

(c) No new substance is made 

(d) Very difficult to reverse 
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2.  In the following chemical reaction which are the reactions?   

Iron + sulphur - iron sulphide 

(a) Iron and iron sulphide 

(b) Iron and sulphur 

(c) Iron, sulphur, and iron sulphide 

(d) Sulphur and iron sulphide 

3.  How many different elements are there in calcium carbonate 

(CaCO3)? 

(a) 2 

(b) 3 

(c) 4 

(d) 5 

4.  Ice melting is an example of a 

(a) A chemical change 

(b) Contemporary change 

(c) Physical change 

(d) Permanent change 

5.  Hydrocarbons contain... 

(a) Carbon and hydrogen only 

(b) Carbon, hydrogen, and oxygen 

(c) Water and carbon 

(d) Water, carbon and oxygen 

Q.No.2  True or False 

1.  Lime water turns milky when carbon dioxide is bubbled through it.       True 

2. During a displacement reaction, one substance combines with other 

substance to make a completely new substance.       False 

3. To burn, a fire needs only a fuel, oxygen and heat.  False 

7 - Sep - 12



4. Decomposition is the breaking up of a single compound into two or more 

simpler products.             True 

5. Glucose is a fuel used by our human body to produce energy. True 

Q.No.3  The list give some examples of changes in everyday life: 

Baking a cake, bending of plastic ruler, cutting paper, melting ice cream, 

ripening of fruit, souring of milk. 

i. Give three examples of a  

a. A physical change  

And: Melting ice cream, cutting paper, bending a plastic ruler.  

b. Chemical change  

And: Burning fuel, rusting a nail, ripening of fruit, souring of milk, 

baking a cake.  

ii. Which of the changes are  

a. Exothermic?  

And: Burning fuel, souring of milk.  

b. Endothermic?  

And: Melting ice cream baking a cake. 

ACTIVITIES FOR STUDENTS 

Q.No.4  Three examples of chemical reactions are listed I-III below 

I- methane is the chemical name for natural gas. Methane burns in 

oxygen to produce heat. Water and carbon dioxide are produced as 

waste products.  

II- iron goes rusty (rust = iron oxide) when it is exposed to water 

and oxygen in the air.  

III- a piece of magnesium ribbon is put into a solution of copper 

sulphur in a test tube. There is a chemical reaction. The magnesium 

dissolves: red-brown species of copper sink to the bottom of the 

tube. 

i. Write word equation for these chemical reactants.  

7 - Sep - 13



ii. Which of these reactions is an example of?  

a. Synthesis (combination) reaction?  

b. A decomposition reaction?  

c. Displacement mint reaction? 

Q.No.5  A student uses the apparatus shown in the diagram to 

prove that there is more carbon dioxide in exhaled air than in the air around 

us. 

 

 

 

 

 

 

 

 

 

i. What is the lime water for? What happens when carbon dioxide 

is bubbled through lime water?  

ii. Explain why exhaled air contains more carbon dioxide than 

inhaled air?  

iii. Why must the student take care to bubble air through the lime 

water at the same rate in both parts of this experiment? 

Practical Activity 

Q.No.5  Burn a piece of magnesium ribbon and note down what 

happens to it. 
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Sardar Kaurey Khan Public H/S School 

Syllabus Breakup Session 2020-21 

Subject S.STUDIES  Class 7th  Term: 1 September 

M Week Dates 
Working 

Days 
Activity Topics / Content 
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2
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0
 

 

14 31-05  6  Chapter no. 10 Rivers and small bodies of water. Reading 

+ find the meanings of difficult words Obstacle, Silt, 

Deposition, Stagnant, Channel, Hazard, Gush, Gurgle. 

15 7-12 

 

6  Chapter no. 10 Content review 

Q.1________Q.4 + M.C.Q’s.  Draw, label and colour two 

important landforms( Cape, Bay, strait )   

16 14-19  

 

6  Chapter no.15 Patriotism   Reading +find the meanings of 

difficult words Committed, Safeguard, Tragedy, Excessive, 

Immigrants, Loyalty, Humanitarian, Allegiance. 

17 21-26 6  

 

Content review   Q.1____Q.3 + M.C.Q’s     Activity Make a 

list of some moments when you feel patriotic towards 

Pakistan. 

18 28Sep-

03 Oct 

6 Self 

Assessment 
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SARDAR KAUREY KHAN PUBLIC HIGHER SECONDARY SCHOOL M.GARH 

SYLLABUS FOR THE MONTH OF SEPTEMBER. 2020 

CLASS: 7th                            SUBJECT: S.STUDIES 

CHAPTER: 10 and 15 

Chapter.10 Rivers and smaller bodies of water 

Q.1 Explain why rivers are an important landform?  

Ans. The movement of water is significant for understanding the environment. Rivers 

shape our landscape and it is important to understand what cause flooding and what 

the effect can be. So rivers are known as agent of erosion and landscape shapers. 

Q2. Name some landforms created by rivers? 

Ans. Meanders 

When the river bends to find a route around the obstacle and continues its journey. 

These bends or turns are called meanders. 

Oxbow lake 

Sometimes silt and mud depositions cutoff the meanders from the main river forming 

a small body of water called an oxbow lake. 

 Water fall 

A waterfall is created when a river flows over an area of both hard and soft rock. 

Estuary and delta 

An estuary is the neck like part of the river’s course just before it meets the sea. 

Delta 

Sometimes a river splits into smaller channels at its mouth. The silt and mud  

carried by the river are deposited and form a triangular piece of land called delta. 
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Q.3.How does a glacier erode rocks? 

Ans. Glacier erodes the underlying rocks by abrasion and plucking. With the weight of 

the ice over them these rocks can scratch deeply into the underlying bedrock making 

long parallel grooves in the bedrock. Glaciers are effective agents of erosion. 

Q.4. Name some important lakes in the World. 

Ans. Most important lakes in the world are; 

a. Lake superior( North America) 

b. Lake victoria(Africa) 

c. Lake Baikal(Russia) 

d. Loch ness(Scot land) 

e. Lake Tanganyika(Africa) 

f. Lake Huron(Canada) 

g. Lake Michigan(U.S.A) 

Civics   Chapter.15 Patriotism 

Q.1What are some advantages of patriotism? 

Ans. Patriotism gives sense of pride and belonging. Positive feelings about one’s own 

country generate hope and encourage people to do their best and work more 

constructive. A feeling of national spirit binds people together to work towards a 

common goal and the welfare of their country. 

Q.2. In what way can patriotism damage our country? 

Ans. Excessive and uncontrolled patriotism can cause problems. Sometimes people 

developed hatred and  negative feelings for other nations ,  a danger which can create 

problems for a country instead of helping its progress. This feeling of animosity creates 

destructive emotions in people 

Q.3. How can a student display patriotism? 

a. Love for one’s country most without hating other countries.  

b. Not indulging in activities that could bring a bad name for the country. 

c. Being proud of his/ her country and all it has to offer,  improving what could be 

made better.  

d. Looking after the interest of his /her country in every possible way. 
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Sardar Kaurey Khan Public H/S School 
Syllabus for the month of September,1st Term 2020 

 
               Subject: ComputerClass:  7th           Teacher: Sadia Kanwal                       

Month Week Dates W.Days Topic/Content 

Sep 
2020 

1 31-05 5 
Unit#3 Explanation of print &web 
layout + font styles 

2 7-12 5 
Alignment+ indentation 
Short  Q11-17 

3 14-19 5 Header& footer+ Watermark 

4 21-26 5 Insert date& time long Q2-5 

5 28-3oct 5 Revision + 2nd Self-Assessment 

 

Unit#3: 

“Customizing a word document” 
 
Short Questions: 
11. Differentiate between Print Layout View and Web Layout View.  
Ans: The print layout view is used when a user wants to see how the document 

will appear on a printed page and the web layout view is used when a user is 

creating a web page. 

12. What is meant by comment in a MS Word document?  
Ans: A comment about a selected text can be added in the document. A comment 
can be a note, explanation or reminder that a user adds to a document.  

 

7 - Sep - 18



2 
 

13. Define different styles of Fonts in MS Word? 
Ans: A user can make the text bold, italic and underlinedto emphasize 
information in the document. Font is a set of printable or displayable text, letters 
and characters in a specific style and size. We can choose different fonts to suit 
the type of a document. You may enhance the appearance of your document by 
changing the font of the text. For example, if you are writing a letter, you may use 
formal fonts(e.g. Times new Roman, Arial, etc).  
 

 
 
14. What is an alignment? How many types of text alignment in MS Word? 
Ans: Alignment arranges the text to line up at one or both margins, or in center 
between the margins. Alignment applies to entire paragraphs. There are four 
types of text alignments. You can align text to the left, right, or center, or you can 
justify your text.  
 

 
 

15. What is indentation? Write the name of any two indentations in MS Word.  
Ans: In Microsoft Word indent is used to describe the distance or number of blank 
spaces used to separate a paragraph from the left or right margins. Word offers 
several indent options i.e. Left Indent, Right Indent etc. 
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16. What is the difference between footer and a footnote?  
Ans:Footer is used to display information on each page of a document. It displays 
information at the bottom of each page. Footnotes or Endnotes are used to 
provide additional information about text in the document such as an 
explanation,comment,reference,etc. 
 

 
 
17. What is a Watermark?  
Ans:Watermarks are text or pictures that appear behind the document text.  
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18. Write down the shortcut keys of print, copy, cut and paste in MS Word.  
Ans:Print     Ctrl+P  

Cut      Ctrl+X 
Copy    Ctrl +C  
Paste  Ctrl+V 
 
Long Questions: 

2. How can we find the synonyms of a difficult word in MS Word?  
Ans: Thesaurus suggests other words with a similar meaning to the selected word. 
Using the Research task pane, a user can look up synonyms (different words with 
the same meaning) and antonyms (words with the opposite meaning) in the 
thesaurus.  

 Open a saved document.  

 Select the word we want to replace with another word.  

 On the “Review Tab” in the “Proofing group”, click “Thesaurus”.  

 The “Research” task pane appears.  

 The selected word appears “Search for” dialogue box.  

 Position the mouse over the word we want to use in the document.  

 Click the arrow beside the word we want to use.  

 Click “insert” to replace the word in the document with the new word. 
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3. Explain the steps to insert Date and Time in MS Word document. 
Ans: A user can insert current date and time into a document. MS Word can 
automatically update the date and time each time we open or take print of the 
document.  

 Open a saved document.  

 Click place where the date and time should appear in the document.  

 On the “Insert Tab”, in the “Text group” click “Date and Time”.  

 The “Date and Time dialogue box will appear on the screen.  

 Click the Date and Time format.  

 Click “OK” to confirm the selections.  

 Selected date and time format will appear in the document.  

 

4. Describe all the positions where page numbers can be inserted. 
Ans:  

 Open a saved document. 

 On the “Insert tab” in the “header & footer group”, click “Page Number”. 

 Click Top of page, Bottom of page, or page margins depending on where we 
want page numbers to appear in the document. 

 
5. Write down the steps to implement header and footer in MS Word 
document. 
Ans: Headers and footers are used to display information on each page of a 
document. Headers display information at the top of each page and footers 
display information at the bottom of each page.  

 Open a saved document.  

 In the “View tab” click the “One Page”.  

 Word can display headers and footers only in the Print Layout view.  

 On the “Insert tab” in the “Header & Footer group” click “Header” and select 
“Blank Header”. 

 Now select “Footer” and select “Alphabet” footer and type the desire words.  

 Click “Close Header and Footer” or double click the document area.  
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MCQs: 

6) MS Word shows the document information on the:  
a. Tool Bar   b. Status Bar 
c. Scroll Bar   d. Progress Bar  
7) Changing the width of the lines in a paragraph is known as :  

a. Indentation  b. Alignment  

c. Gradient   d. Spacing  

8) Which of following key is used to position the text on a specific location :  

a. Tab   b. Space  

c. Backspace  d. Arrow  

9) Which of following is a point where current page ends and a new page 
begins:  

a. Page Break  b. Point Break  
c. Section Break  d. Paragraph Break  
10) _____________ is amount of spaces between the text and edges of a paper.  

a. Border  b. Alignment  c. Margin  d. Water Mark  

11) Hard page break is also known as :  
a. Manual page break   b. Soft page break  
c. Long page break   d. Short page break  
12) Soft page break is also known as :  
a. Manual page break  b. Automatic page break  
c. Hard page break  d. Short page break  
13) Which of following are text or picture that appear behind the document 
text:  
a. Page Margin  b. Page Number  
c. Watermarks  d. Bullets 

14) Always preview a document before:  
a. Reading   b. Printing  
c. Breaking   d. All of these  
15) Which of following is the way that text placed between the margins of a 
page:  
a. Pasting   b. Watermark  
c. Numbering  d. Printing 
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SARDAR KAUREY KHAN PUBLIC HIGHER SECONDARY 

SCHOOL 

MUZAFFARAGRH 

Subject: Mathematics  Teacher: Sumera Mukhtar  Class: VII 

 

M Week Dates 
Working 

Days 
Activity Topics/Content 

Se
p

te
m

b
er

 2
0

2
0

 1 31-05 6  
Definition of Fundamental 
Geometry + Ex.10.1(Half) 

2 7-12 6  Ex.10.1 (half) 

3 14-19 6  Ex.10.2 

4 21-26 6  Revision 

5 
28-03 

Oct 
6  Revision + Self-Assessment 
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Notes for the month of September  2020
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 ___________________  (1)

 _____________________     (2)

 ___________________  (3)

_____________  (4)
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SELF-ASSESSMENT #2  English Class 7th  SEPTEMBER, 2020. 

 Name: ______________________  Date ______________ T.marks: 25. 

Q:1 Complete the following proverbs.              (3)  

1: Prevention is better ________.  

2: Think before __________.  

3: ________ seldom bites.  

4: Where there is a will, ___________.  

5: Knowledge is __________.  

6: All that glitters __________.  

Q:2 Fill in the blanks with suitable articles (a,an,the).      

(3)  1: ___ poor.         2: ___ ten rupee note.       3: What __ 

pity. 

4: ___ MA.           5: ___ heir.  6: ___ most expensive 

Q:3 Make Sentences.        (4) 

1: famous.     2: harsh.  3: seldom.     4: better. 

Q:4 Choose the correct word from the bracket. 

(3) 1: They (live / lives) in the colony.

2: Their questions (puzzle / puzzles) me.  

3: Worms (eat / eats) these leaves.  

4: This market (cater / caters) to the people of this area.  

5: The soldiers (march / marches) in perfect harmony with the band.  

6: Scarcity of water (affect / affects)plants and animals as well.  

Q:5 Read the following passage and answer the questions given at the end. 

(4) 

Once a stag was drinking at a stream. He happened to see his reflection in the 

water. He was pleased to see his beautiful horns, but when he saw his thin 

legs, he felt sad as he thought they were ugly. Suddenly, he saw a pack of 

hounds at a distance.   
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He ran as fast as his legs could help him. Soon he left the hounds far behind. 

He had to pass through a thick forest of bushes. His horns got caught in a 

bush. He tried hard to pull his horns out of it but all in vain. By now the hounds 

had come up. They fell upon him and tore him into pieces. 

QUESTIONS  

1. What was the stag doing?

2. Why was he pleased?

3. Why did he run?

4. How did his legs help him?

Q:6 Write down the meanings of the following phrasal verbs (You may 

consult G.T).  (3) 

1: break down.         2: put off.          3: run into 

Q: 7 Write  a few lines on “ My daily Routine”.                                 (5) 

________________________________________________________________

________________________________________________________________

________________________________________________________________

________________________________________________________________

________________________________________________________________

________________________________________________________________

________________________________________________________________

________________________________________________________________

________________________________________________________________ 
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SARDAR KAUREY KHAN PUBLIC HIGHER SECONDARY SCHOOL MUZAFFARGARH 

ASSESSMENT FOR THE MONTH OF AUGUST & SEPTEMBER 

SUBJECT: SCIENCE                                                                                        CLASS: VII 

NAME: __________________________________ 

 Multiple Choice Questions.  1x10=10 

1-Heart attack is a blockage of the... 

(a) Carotid artery carrot    (b) Carotid vein 

(c) Coronary artery     (d) Coronary vein 

2.  Asthma is caused by tubes in the lungs becoming... 

(a) Longer      (b) Narrower 

(c) Shorter      (d) Wider 

3. Ice melting is an example of a 

(a) A chemical change    (b) Contemporary change 

(c) Physical change     (d) Permanent change 

4. Where on a magnet is the magnetic field strongest? 

(a) At both North and South Pole  (b) At the North Pole 

(c) At the South Pole    (d) In the middle 

5. Asthma is caused by tubes in the lungs becoming... 

(a) Longer      (b) Narrower 

(c) Shorter      (d) Wider 

6. Burning of fire needs: 

a) Fuel      b)Oxygen 

c)Heat      d)All of these 

7. How many types of elements are in (CaCO3)? 

a) 3       b)4 

 c)5       d)6 
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8. Chemical name for rust is: 

a) Calcium Oxide     b)Iron Sulphide 

c)Iron oxide      d)Calcium Carbonate 

9. Copper wire is a _____________ material. 

a)Magnetic      b)Non-magnetic 

c)Both a&b      d)None of these 

10. Diseases caused by smoking is/are: 

a)Lung cancer     b)Emphysema 

c)Bronchitis      d)All of these 

Q.No.2 Give short answers.  5x2=10 

i. Is magnesium burning in oxygen exothermic or endothermic? 

ii. Differentiate between a chemical change and physical change. 

iii. What are anesthetics used for? 

iv. What are tranquilizers? 

v. What is induced magnetism? 

Q.No.3 Long questions    /5 

 Explain the difference between exothermic and endothermic reactions? 
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SARRRDAR KAUREY KHAN HIGHER SECONDARY SCHOOL M.GARH 

SELF-ASSESSMENT of   August/ September 2020. 

CLASS:7th                               SUBJECT: S.STUDIES 

NAME:____________________________ TOTAL MARKS: 15 

NOTE: Mark tick on the correct option.   /5 

1.__________  are  the native animals of the river Indus. 

a. blind dolphin and bear  b. green macaw, blind dolphin   c. turtle, shark 

2.Water contains _______ is natural treatment  for skin problem like leprosy. 

a. Salt       b. Sulphur           c. silt    

3. For every thousand parts of water in ocean, there are about __ parts of salt. 

a. 30              b. 45             c. 35 

4. If all the water in all the oceans dried up, the layer of salt left behind on ocean floor 

would be about __________ thick. 

a. 66metres          b. 76metres                      c. 56metres 

5. A bay is a sheltered, usually _____ shaped landform. 

a. D          b. C          c. Q  

Answer these questions:          /10 

Q.1  Which sea  has the highest number of islands and rocks projections in the world? 

Ans: __________________________________________________________________ 

______________________________________________________________________  

Q.2  What is river system? 

Ans:___________________________________________________________________

______________________________________________________________________  
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Q.3: Write a note on waterfall? 

______________________________________________________________________ 

______________________________________________________________________ 

Q.4: Write down the difference between bay and gulf? 

Ans:___________________________________________________________________

______________________________________________________________________ 

Q.5: Why do tides occur? 

Ans:___________________________________________________________________

______________________________________________________________________ 

______________________________________________________________________ 
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Self Assessment for the month of August& September 
 
  Subject: Computer  Class: 7th 
Section: ______________                    Date: ______  
  Name:_______________  
 
Q1) Encircle the correct option.                                                              /10 
1. A computer software that helps users to do a specific task on a computer is 
called  
a. Application Softwareb. Utility c. System Software d. MS Office  
2. Which of following software are used to create visual presentation?  
a. Multimedia b. MS Paint     c. Typing Tutor d. MS Word 
3. MS Word offers how many views of a documents :  
a. Two b. Three c. Four d. Five 
4.Delete key deletes letters from the:  
a. Right Sideb. Left Side     c. Up Side d. Down Side  
5.Which of the following view is the best way to see the work in MS Word:  
a. Draft       b. Outline      c. Full Screen Reading d. Print Layout 
6. _____________ is amount of spaces between the text and edges of a paper.  
a. Border b. Alignment c. Margin d. Water Mark  
7.Which of following key is used to position the text on a specific location :  
a. Tab  b. Space  c. Backspace  d. Arrow  
8. Which of following are text or picture that appear behind the document text:  
a. Page Margin  b. Page Number  c.Watermarks d. Bullets 
9.MS Word shows the document information on the:  
a. Tool Bar  b. Status Bar  c. Scroll Bar  d. Progress Bar  
10. Encyclopedia is an example of:  
a. Reference Software b. Multimedia Software  
c. Entertainment Software  d. Educational Software  
Q2). Give short answer to the following questions:                              /10 
1. List the names of any four Application Software.  
___________________________________________________________________
___________________________________________________________________ 
___________________________________________________________________ 
2. Define the Reference Software. 
___________________________________________________________________
___________________________________________________________________ 

 
  ____ 
    25 
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___________________________________________________________________ 
3. Differentiate between Print Layout View and Web Layout View.  
___________________________________________________________________
___________________________________________________________________ 
___________________________________________________________________ 
4. What is the difference between footer and a footnote? 
___________________________________________________________________
___________________________________________________________________ 
___________________________________________________________________ 
5. Define Undo and Redo action. 
___________________________________________________________________
___________________________________________________________________ 
___________________________________________________________________ 
Q3). Write down the shortcut keys of print, copy, cut and paste in MS Word. /2 
              Print ___________           Copy ____________ 
              Cut ____________           Paste ___________ 
Q4).List any three Productivity Software.   /3 
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SARDAR KAUREY KHAN PUBLIC HEIGHER SECONDARY SCHOOL 

MUZAFFARGARH 

ASSESSMENT FOR THE MONTHS OF SEPTEMBER, 2020 

SUBJECT: - MATHEMATICS   CLASS: -  7
th

 

Total Marks: - 25  Time Allowed: -  40 Minutes 

Teacher’s Name: - SUMERA MUKHTAR 

Students Name:- 

Q.No.1 Tick ✔ the correct answer.(Marks 15) 

i If the perimeter of a square shaped garden is 112 meter, then its area is  

(a) 784 m
2 
  (b)  1600 m

2
  (c)  400 m

2
  (d) 874 m

2
 

ii √4096 = 

(a) 36    (b)  64    (c)  25    (d)  34 

iii √333.0625 = 

(a) 17.35    (b)  25.35    (c)  18.25   (d)  None 

iv Which of the following is a perfect square? 

(a) √(16+9)   (b)  √(25+9)   (c)  √(16÷9)   (d)  None 

v The number whose square root is non-terminating and non-recurring 

decimal is called -----------number. 

(a) Natural  (b) Complex   (c) Irrational  (d)  None 

vi To represent the square root we use symbol √ which is called-----------. 

(a) Radical  (b) Fraction  (c) Integer  (d) None 

vii The square of a decimal less than 1 is ----------- than itself. 

(a) Larger  (b) Smaller  (c) Equal  (d) None 

viii The product of a number with itself is called ----------- 

(a) Square  (b) Cube  (c) Square Root  (d) None 

ix Comparison between two alike quantities is called --------- 

(a) Proportion  (b) Ratio  (c) Inverse  (d) Direct 
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x A relation in which one quantity increase or decreases in the same 

proportion by increasing or decreasing the other quantity is called --------- 

(a) Inverse  (b) Continued  (c) Direct  (d) None 

xi Distance =  ----------- × time. 

(a) Speed   (b) Velocity  (c) Length  (d) None 

xii If 4:6 :: x:24 then x =  --------- 

(a) 12  (b) 16  (c) 20  (d)  8 

xiii An interval between two happenings is called ------- 

(a) Speed  (b) Distance  (c) Time  (d) None 

xiv When we convert 72 km/hr into m/sec we get 

(a) 2m/sec  (b) 20 m/sec  (c) 5 m/sec  (d) 10 m/sec 

xv The combination of two ratios of three quantities is called --------- 

(a) Continued Ratio  (b) Proportion  (c) Inverse  (d) Direct 

Q.No.2 Write the short answers. ( Marks 10) 

i Find the square root of 4596.84 by division method. 

ii By which smallest number 648 can be divided to get a perfect square. 

iii If l:m = 1:7 and l:n = 5:6 then find l:m:n 

iv Find value of m when 0.21:6.3 = 0.06:m 

v Ten boys complete a work in four days, then in how many days twenty 

boys will complete the same work. 
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 Self Assessment for the month of August & September 2020

Subject:   Urdu      Class: 7th             Sec: __________ 

Name: __________  Total Marks:  25   Date: __________


    1

    2





   3

    4

    5

    6

 22  22  21  7

    8

    9

    10

    11

    12

    13

    14

    15

  2 



 1

 2

 3

 4

 5
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SARDAR KAUREY KHAN PUBLIC HIGHER SECONDARY SCHOOL 

MUZAFFARGARH 

ASSESSMENT FOR THE MONTH OF AUGUST & SEPTEMBER 

NAME: ___________________   SUBJECT: ISLAMIAT       CLASS: VII 

 درتس وجاب ےک رگد اشنن اگلےیئ۔                                                                                       

  یھت۔ــــــــــحتف ہکم ےک ومعق رپ املسمونں ےک رکشل یک دعتاد -1

 زہار 8(ج) زہار   10 (ب) زہار   5 (افل

 درمہ ےجیھب۔ ــــــــــــــــــاعلم رحبنی ےن - 2

 زہار 10دو الھک(ج) زہار  10اکی الھک (ب) زہار  10نیت الھک (افل

 اہک ایگ۔ ــــــــــــرقآن اپک ںیم املسمونں وک -3

اتُم بح ( ج)اتُم وطس   (ب)اتُم تخت   (افل

سک ےلیبق یک وعرت وچری ےک رجم ںیم ڑکپی یئگ۔ -4

ونب زخموم ( ج)ونب رکب   (ب)ونب دعی   (افل

 ہصح انیل اچےیہ۔ ــــــــــــــــںیمہ رجش اکری ںیم -5

یھبک اھبکر ( ج)ڑبھ ڑچھ رک  (ب)یھبک ںیہن   (افل

 وساولں ےک رصتخم وجاابت رحتری رکںی۔ 

 ل ےک دو اصقنانت ایبن رکںی۔
ُ

 

خ
ب 

 

 ینمش ںیم ایک روہی اایتخر رکےن اک مکح دای ایگ ےہ۔
ُ
 دویتس اور د

 ںیمہ سک مسق ےک رھگ ریمعت رکےن اچےیہ؟ 

 رضحت اوب رکب وک تیب ااملل ےس ینتک وخنتاہ یتلم یھت؟ 

 رضحت اعہشئ ےن وکن وکن ےسزغوات ںیم رشتک یک؟ 
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